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Nodiadau arweiniad   Taenlen adennill costau llawn 
 

 
 

Gellir lawrlwytho dwy daenlen 

i'ch helpu cyfrifo costau llawn 

eich prosiect: 

►Y daenlen adennill costau 

llawn: Defnyddiwch y daenlen 

adennill costau llawn i 

amcangyfrif costau llawn eich 

prosiect a maint y grant 

rydych yn gofyn amdano 

gennym. Am enghraifft 

ymarferol, gweler enghraifft 

Canolfan Gymunedol Ioan 

Sant yn y llyfryn: “Ymgeisio 

am gostau cyffredinol eich 

prosiect: arweiniad i 

Ymgeiswyr i Gronfa 

Gymunedol y Loteri 

Genedlaethol”. 

► Y daenlen cyflogau: 

Defnyddiwch y daenlen 

cyflogau i gyfrifo costau 

cyflogau llawn eich 

cyflogeion.  

Mae wyth cam i'r daenlen. 

Dilynwch bob cam yn ôl ei 

drefn. Ar ôl cwblhau un cam, 

sgroliwch i lawr i gyrraedd y 

cam nesaf. Y camau yw:  

► Nodwch fanylion am y 

prosiect a'r cyfnod y bydd y 

prosiect yn rhedeg.  

► Nodwch gostau uniongyrchol 
y prosiect 

► Disgrifiwch y mathau 

gwahanol o gostau 

cyffredinol yn eich prosiect a 

sut y caiff pob math ei rannu 

rhwng prosiectau eich 

mudiad. 

► Nodwch sut caiff y costau 

cyffredinol eu rhannu rhwng 

prosiectau eich mudiad. 

► Nodwch amcangyfrif o 

gostau cyffredinol eich 

mudiad. 

► Cyfrifir costau llawn eich 

prosiect. 

► Os byddwch yn codi 

cyfraniadau tuag at eich 

prosiect o ffynonellau eraill, 

nodwch y manylion yma. 

► Mae'r cam hwn yn cyfrifo'r 

uchafswm cyfraniad y gallwn 

ei wneud tuag at eich 

prosiect. 

Esbonnir pob cam yn fanylach 

ar y tudalennau a ganlyn.  

Fformatau taenlen 
Mae'r daenlen adennill costau 

llawn ar gael mewn dau 

fformat:  

● fel llyfr gwaith Microsoft 

Excel: sy'n gweithio gyda 

fersiynau 5.0, 95, 97, 2000, 

XP, 2003 a hwyrach o 

Microsoft Excel 
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Os nad ydych erioed wedi defnyddio taenlenni o'r blaen rydym yn 

argymell i chi gael cymorth cyn dechrau. Gallwch gyfeirio at 

Gymorth y meddalwedd hefyd.  

● yn Excel dewiswch Help -> Microsoft Excel Help o far dewislen 
Excel 

Nodi rhifau 
● dewiswch y cell perthnasol 

● teipiwch y rhif gyda'r bysellfwrdd. Peidiwch â theipio 

arwydd £. Peidiwch â theipio comas. Er enghraifft: i nodi 

£1,250 teipiwch 1250 NID £1250 neu 1,250 neu £1,250 

● gwasgwch Enter/Return (). 

Ychwanegu rhesi ychwanegol 
Yng nghamau 2, 4, 5 a 7 gallai fod angen i chi ychwanegu rhesi at 

y gridiau mewnbynnu data. I ychwanegu rhesi, dewiswch gell yn y 

grid mewnbynnu data, yna:  

● ym Microsoft Excel: o'r bar dewislen dewiswch Insert -> Rows 
 

Bydd rhes newydd yn cael ei mewnosod yn y rhes uwchben y 

cell a ddewiswch.  

 

 

Nodyn ar gyfer defnyddwyr Microsoft Excel fersiynau 5, 95, 97 a 

2000: Yn ddiofyn mae celloedd penodol wedi'u diogelu. Mae hyn 

yn eich atal rhag golygu'r celloedd hyn ac fe'i dylunnir i ddiogelu 

fformiwlâu'r daenlen rhag difrod anfwriadol. Yn y fersiynau hyn o 

Excel mae diogelu celloedd yn eich atal rhag mewnosod rhesi 

newydd. I fewnosod rhesi newydd yn y fersiynau hyn mae'n rhaid 

i chi ddad-ddiogelu'r daenlen yn gyntaf. O'r bar dewislen 

dewiswch Tools -> Protection -> Unprotect Sheet. Ar ôl 

ychwanegu rhesi dylech ail-ddiogelu'r dalen waith i atal difrod 

anfwriadol i fformiwlâu. 

O'r bar dewislen dewiswch Tools -> Protection -> Protect Sheet. 

 

 

Cam 1: Gwybodaeth am eich 
prosiect 

1.1 Enw’r mudiad: Nodwch enw 

eich mudiad. 

1.2 Enw'r prosiect: Nodwch 

enw'r prosiect rydych yn gofyn 

i ni ei ariannu.  

1.3 Blwyddyn ariannu: 

Disgrifiwch ym mha flwyddyn y 

bydd eich prosiect yn digwydd. 

Er enghraifft, nodwch 2019 os 

bydd eich prosiect yn digwydd 

yn 2019. Os bydd eich prosiect 

yn rhedeg rhwng 1 Ebrill 2019 a 

31 Mawrth 2020, nodwch 

2019/2020. 

Os bydd eich prosiect yn para 

am fwy na blwyddyn, mae'n 

rhaid i chi  roi gwybod i ni faint 

rydych eisiau i ni ei gyfrannu at 

eich prosiect ym mhob 

blwyddyn.  

Mae'n rhaid i chi naill ai:  

● greu taenlenni ar wahân ar 

gyfer bob blwyddyn neu 

● greu taenlen ar gyfer y 

flwyddyn gyntaf, yna 

chwyddo'r ffigurau i gyfrifo'ch 

cais am ariannu ar gyfer y 

blynyddoedd canlynol. Bydd 

hyn yn briodol os bydd costau 

uniongyrchol eich prosiect, 

costau cyffredinol eich  

mudiad ac unrhyw incwm arall 

a godir ar gyfer eich prosiect o 

ffynonellau eraill yr un peth, 

yn amodol ar chwyddiant, yn y 

blynyddoedd a ganlyn. 
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1.4 Wythnosau prosiect yn y 

flwyddyn ariannu:  

Os bydd eich prosiect yn rhedeg 

dim ond am ran o'r flwyddyn a 

ddisgrifir yn 1.3, nodwch am 

faint o wythnosau y bydd yn 

rhedeg. Os bydd y prosiect yn 

rhedeg am y flwyddyn gyfan, 

nodwch 52 neu gadewch yn 

wag. 

1.5 Canran o'r flwyddyn 

ariannu: Dyma'r ganran o'r 

flwyddyn y bydd eich prosiect 

yn rhedeg.  

Cam 2: Nodwch gostau 
uniongyrchol eich prosiect 
Yn y cam hwn rydych yn nodi 

costau uniongyrchol eich 

prosiect. Costau uniongyrchol 

eich prosiect yw'r costau y gellir 

eu priodoli'n glir ac yn 

uniongyrchol i'ch prosiect. 

Cyfeiriwch at y llyfryn "Ymgeisio 

am gostau cyffredinol eich 

prosiect: arweiniad i ymgeiswyr 

i Gronfa Gymunedol y Loteri 

Genedlaethol" am gymorth 

gydag adnabod costau 

uniongyrchol eich prosiect.  

Dylech:  

● nodi symiau mewn £ cyfan 

yn unig. Peidiwch â nodi 

ceiniogau; mae angen i chi 

nodi'r arwyddion £ 

● nodwch y costau disgwyliedig 

ar gyfer y cyfnod a ddisgrifir 

yng ngham 1. Cofiwch 

ddarparu ar gyfer chwyddiant 

os ydych yn seilio'r rhain ar 

gostau cyfredol. Os bydd eich 

prosiect yn rhedeg dim ond 

am ran o'r flwyddyn ariannu 

(gweler 1.3), dylech ddarparu 

ar gyfer hwn wrth gyfrifo 

costau. Er enghraifft, os bydd 

eich prosiect yn para am 30 

wythnos, ac rydych yn 

disgwyl gwario £20 yr 

wythnos ar dreuliau 

gwirfoddolwyr, dylech nodi 

 

£600 (= 30 wythnos x £20) ar 

gyfer treuliau gwirfoddolwyr. 

Cofiwch hepgor yr arwydd £ 

wrth nod rhifau, a 

thalgrynnwch symiau i'r £ 

agosaf 

● rhannwch gostau 

uniongyrchol eich prosiect 

rhwng costau refeniw a 

chostau cyfalaf. Mae costau 

cyfalaf yn daliadau sylweddol 

ar gyfer eitemau a fydd yn 

para am nifer o flynyddoedd, 

er enghraifft: dodrefn, 

cerbydau, cyfarpar a 

meddalwedd cyfrifiadurol. 

Cyfeiriwch at y llyfryn 

"Ymgeisio am gostau 

cyffredinol eich prosiect: 

arweiniad i ymgeiswyr i 

Gronfa Gymunedol y Loteri 

Genedlaethol” am gymorth. 

Nodwch gostau cyfalaf yn y 

golofn costau cyfalaf. 

Nodwch bob math arall o 

gost yn y golofn costau 

refeniw.  

Cam 3: Disgrifiwch sut 
caiff costau cyffredinol 
eich mudiad eu rhannu 
Yma rydych yn disgrifio sut 

caiff costau cyffredinol eich 

mudiad eu rhannu rhwng 

prosiectau eich mudiad. Y 

dulliau cyffredinol o rannu 

costau cyffredinol yw:  

● defnyddio'r nifer o 

staff sy'n gweithio ar 

bob prosiect 

● defnyddio'r nifer o 

ddefnyddwyr ym mhob 

prosiect 

● defnyddio'r arwynebedd 

llawr a ddefnyddir gan bob 

prosiect 

● defnyddio oriau agor pob 

prosiect. 

Mae'n rhaid i chi ddewis dull 

sy'n deg ac yn rhesymol. Dylai'r 

dull adlewyrchu'r ffordd y mae 

costau cyffredinol yn cael eu 

cynhyrchu. Er enghraifft, os yw 

rheolwr yn treulio'r rhan fwyaf 

o'u hamser yn rheoli staff, 

gallai niferoedd staff fod yn 

ddull priodol o rannu costau'r 

rheolwr. Cyfeiriwch at y llyfryn 

"Ymgeisio am gostau 

cyffredinol eich prosiect: 

arweiniad i ymgeiswyr i Gronfa 

Gymunedol y Loteri 

Genedlaethol” am gymorth 

gyda dewis dull. 
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Os yw'n briodol rhannu'r holl 

gostau cyffredinol yn yr un 

ffordd, llenwch y golofn gyntaf 

(Cost Gyffredinol Math 1) a 

gadewch y ddwy golofn arall yn 

wag.  

Weithiau nid yw'n briodol 

rhannu'r holl gostau cyffredinol  

yn yr un ffordd. Os daw mathau 

gwahanol o gost gyffredinol i'r 

amlwg mewn ffyrdd gwahanol, 

ac mae'r symiau dan sylw yn 

rhai sylweddol, dylech rannu 

pob math o gost gyffredinol ar 

wahân.  

Gweler yr enghraifft Canolfan 

Gymunedol Ioan Sant yn y 

llyfryn "Ymgeisio am gostau 

cyffredinol eich prosiect: 

arweiniad i ymgeiswyr i Gronfa 

Gymunedol y Loteri 

Genedlaethol” am eglurhad. 

Mae costau'r adeilad yn 

sylweddol yng Nghanolfan 

Gymunedol Ioan Sant, ond nid 

yw rhai prosiectau'n defnyddio'r 

adeilad. 

 Fodd bynnag, mae angen 

cefnogaeth weinyddol a rheoli 

ar bob prosiect. Rhennir costau 

adeiladau trwy gyfrifo defnydd 

pob prosiect o'r adeilad, ond 

rhennir costau cefnogi 

gweinyddol a rheoli trwy gyfrifo 

nifer y staff sy'n gweithio ym 

mhob prosiect.  

Mae'r daenlen yn galluogi 

chi i rannu costau 

cyffredinol mewn hyd at 

dair ffordd wahanol.  

3.1 Math o gost gyffredinol: 

Disgrifiwch y math o gost 

gyffredinol. Er enghraifft: 

gweinyddu a chefnogaeth, 

rheolaeth gyffredinol, costau 

adeiladau. Os yw'r holl gostau 

cyffredinol i'w rhannu yn yr un 

ffordd, llenwch "Pob Cost 

Gyffredinol" yn y golofn gyntaf 

(Cost Gyffredinol Math 1) a 

gadewch y colofnau eraill yn 

wag. 

3.2 Sut caiff y costau 

cyffredinol eu rhannu: 

Disgrifiwch sut caiff pob math o 

gost gyffredinol ei rannu rhwng 

prosiectau eich mudiad. Er 

enghraifft: nifer y staff, 

arwynebedd llawr a ddefnyddir, 

nifer y defnyddwyr. Os yw'r holl 

gostau cyffredinol i'w rhannu yn 

yr un ffordd, disgrifiwch sut 

caiff pob cost gyffredinol ei 

rhannu yn y golofn gyntaf (Cost 

Gyffredinol Math 1) a gadewch 

y colofnau eraill yn wag. 

Cam 4: Rhannwch y costau 

cyffredinol  

Yn awr cyfrifwch gyfran eich 

prosiect o'r costau cyffredinol. 

4.1 : Eich prosiect:  

Mae'n rhaid i'r prosiect sy'n cael 

ei gostio fod yn y rhes gyntaf. 

4.2 Prosiectau eraill:  

Yn y golofn sydd wedi'i labelu 

fel “Prosiect”, disgrifiwch y 

prosiectau eraill yn eich 

mudiad. Mae'n rhaid i chi 

gynnwys pob prosiect yn y 

mudiad, ond nid oes angen 

rhestru pob prosiect arall ar 

wahân; er enghraifft, gallech 

chi nodi "Pob Prosiect Arall" yn 

yr ail res neu fe allech restru 

pob prosiect ar wahân.  

4.3 : Costau cyffredinol:  

Mae'r rhesi costau cyffredinol yn 

caniatáu i chi rannu costau 

cyffredinol rhwng mathau 

gwahanol. Gweler yr enghraifft 

Canolfan Gymunedol Ioan Sant 

yn y llyfryn "Ymgeisio am gostau 

cyffredinol eich prosiect: 

arweiniad i ymgeiswyr i Gronfa 

Gymunedol y Loteri 

Genedlaethol” am eglurhad. 



5 ACLl: ARWEINIAD AR GYFER 
TAENLENNI 

 

 
 
 
 
 
 
 
 
 
 
 
 

 

Ar gyfer pob prosiect, nodwch y 

niferoedd a ddefnyddir i rannu'r 

costau cyffredinol yn y colofnau 

eraill. Er enghraifft, os ydych yn 

seilio rhannu costau cyffredinol 

ar y nifer o staff, nodwch nifer 

staff y prosiect yn erbyn pob 

prosiect. Er enghraifft, os ydych 

yn seilio rhannu costau 

cyffredinol ar y nifer o 

ddefnyddwyr prosiect, nodwch 

nifer y defnyddwyr yn erbyn pob 

prosiect. Os ydych yn rhannu 

mathau gwahanol o gostau 

cyffredinol mewn ffyrdd 

gwahanol, bydd angen i chi 

ddarparu niferoedd ar gyfer pob 

math o gost gyffredinol.  

Dylai'r niferoedd fod ar y lefelau 

a ddisgwylir yn y cyfnod 

prosiect a bennwyd yng ngham 

1. Os bydd unrhyw brosiect yn 

rhedeg am ran o'r flwyddyn, 

cofiwch ddarparu ar gyfer hyn. 

Er enghraifft, os ydych yn 

defnyddio niferoedd staff fel 

sail rhannu costau, a bydd 

prosiect yn cyflogi  tri o staff 

am hanner y flwyddyn, nodwch 

1/2 x 3 = 1.5 yn erbyn y prosiect 

hwnnw. 

  

● Cynnydd mewn gweithgarwch 

o ganlyniad i'ch prosiect: 

mae'r daenlen yn cyfrifo'r 

gweithgarwch ychwanegol a 

gynhyrchir gan eich prosiect.  

● Canran o ganlyniad i'ch 

prosiect: mae'r daenlen yn 

cyfrifo cyfran eich 

prosiect o bob math o gost 

gyffredinol.  

Cam 5: Nodwch gostau 
cyffredinol eich mudiad  
Yn awr nodwch yr holl gostau 

cyffredinol ar gyfer eich mudiad 

cyfan. Rhestrwch y costau 

cyffredinol gwahanol yn eich 

mudiad. Os creoch nifer o 

fathau o gostau cyffredinol yng 

ngham 3, penderfynwch i ba 

fath y mae pob cost gyffredinol 

yn perthyn a nodwch y swm yn 

y golofn gyfatebol.  

Nodwch y costau cyffredinol a 

ragfynegir ar gyfer y flwyddyn 

gyfan a bennwyd yng ngham 1. 

Os bydd y prosiect yn rhedeg 

dim ond am ran o flwyddyn, 

bydd y daenlen yn addasu ar 

gyfer hwn gan ddefnyddio'r 

ganran a gyfrifwyd yng ngham 

1.5. Gweler y llyfryn "Ymgeisio 

am gostau cyffredinol eich 

prosiect: arweiniad i ymgeiswyr 

i Gronfa Gymunedol y Loteri 

Genedlaethol" am gyngor ar sut 

i ragfynegi costau cyffredinol yn 

y dyfodol.  

Cam 6: Costau llawn 
eich prosiect 
Pan fyddwch wedi cwblhau'r 

pum cam cyntaf mae'r daenlen 

yn cyfrifo costau llawn eich 

prosiect yng Ngham 6. Nid oes 

angen i chi wneud unrhyw beth 

yng ngham 6, mae'r cyfan wedi'i 

gyfrifo drosoch chi.  

Os ydych yn gofyn i ni ariannu'r 

prosiect cyfan, dyma'r ffigurau 

y dylech eu nodi ar y ffurflen 

gais. Os ydych yn bwriadu codi 

arian ar gyfer y prosiect o 

ffynonellau eraill, ewch ymlaen 

at Gam 7.  

Cam 7: Cyllid o 
ffynonellau eraill 
Os bydd y prosiect yn codi incwm 

o ffynonellau eraill (er 

enghraifft, o gyrff dyfarnu grant 

eraill neu drwy godi tâl), nodwch 

y manylion yma. Nodwch yr holl 

incwm rydych yn disgwyl ei godi 

yng nghyfnod y prosiect. Dylech 

gynnwys yr holl incwm rydych yn 

rhagweld ei godi ar gyfer y 

prosiect hwn. Dylech gynnwys 

unrhyw gyfraniadau tuag at 

gostau cyfalaf a chostau 

cyffredinol a wneir gan arianwyr 

grant eraill. 

  

Os oes cyfraniadau sydd ar gyfer 

costau cyffredinol yn unig, 

nodwch nhw o dan "ffynonellau 

incwm a all gael eu defnyddio 

dim ond ar gyfer costau 

cyffredinol".  

Nodwch y swm y mae'r 

mudiad cyfan yn ei dderbyn 

o'r ffynonellau hyn. Bydd y 

daenlen yn dyrannu'r swm y 

mae'r prosiect yn ei dderbyn 

o'r ffynonellau hyn yn 

awtomatig. 
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Y daenlen gyflogau 
 

 
 

 

Os oes cyfraniadau sydd ar 

gyfer costau prosiect yn unig, 

nodwch nhw o dan "ffynonellau 

incwm a all gael eu defnyddio 

dim ond ar gyfer costau 

prosiect uniongyrchol y prosiect 

hwn". 

Nodwch bob cyfraniad arall o 

dan "ffynonellau incwm eraill a 

all gyfrannu at gostau 

uniongyrchol y prosiect a 

chostau cyffredinol”. Peidiwch 

â nodi cyfraniadau gennym ni.  

Cam 8: Y cyfraniad y 
gallwch ofyn i ni ei wneud 
Pan gwblheir cam 7, mae'r 

daenlen yn cyfrifo'r uchafswm 

cyfraniad y gallwch ofyn i ni ei 

wneud tuag at eich prosiect yn 

awtomatig. Nid oes angen i chi 

wneud unrhyw beth yng ngham 

8, mae'r cyfan wedi'i gyfrifo 

drosoch chi. 

 

Defnyddiwch y daenlen 

cyflogau i gyfrifo costau cyflog 

llawn eich staff. Mae hyn yn 

cynnwys eu tâl crynswth, 

cyfraniad yswiriant gwladol 

cyflogwyr ac unrhyw gyfraniad 

pensiwn cyflogwyr. 

Cyfraniadau Yswiriant 
Gwladol Cyflogwyr  

Os bydd cyflogai'n ennill 
uwchben trothwy penodol (y 
"trothwy enillion eilaidd"), 
mae'n rhaid i chi dalu cyfraniad 
yswiriant gwladol cyflogwyr 
mewn perthynas â'r cyflogai 
hwnnw. 

 Mae'n rhaid i hyn gael ei dalu i 

chi gan Gyllid a Thollau EM. 

Dyma gost ychwanegol cyflogi 

staff ac mae'n rhaid darparu ar 

ei chyfer yn eich cyfrifiadau 

costau staff.  

Pennir y trothwy a chyfradd 

cyfraniadau yswiriant gwladol 

cyflogwyr yng nghyllideb y 

llywodraeth bob blwyddyn. 

Maent yn ymgeisio am 

flwyddyn dreth (Ebrill-

Mawrth) a gallant newid o un 

flwyddyn dreth i'r llall. 

Gwiriwch fod y trothwy a'r 

gyfradd yswiriant gwladol 

cyflogwyr yn gywir ar gyfer 

cyfnod y prosiect. Os nad yw'r 

trothwy a chyfradd yswiriant 

gwladol cyflogwyr wedi'u pennu 

eto ar gyfer cyfnod y prosiect, 

defnyddiwch y cyfraddau 

diweddaraf sydd ar gael.  

 

Os ydych yn ansicr siaradwch â'r 

sawl sy'n rheoli eich cyflogres 

neu gwiriwch wefan Cyllid a 

Thollau EM yn: 

http://www.hmrc.gov.uk/rates/

nic.htm. 

Os yw eich mudiad yn 

gweithredu cynllun pensiwn, 

gwiriwch gyda'r sawl sy'n rheoli 

eich cyflogres gan y gall 

effeithio ar gyfraddau yswiriant 

gwladol.  

Cyfraniadau pensiwn 
cyflogwyr 
Os bydd gan unrhyw un o'ch 

cyflogeion hawl i gyfraniad 

pensiwn cyflogwyr, nodwch y 

gyfradd cyfraniad pensiwn 

cyflogwyr yng ngholofn F, fel 

arall gadewch y golofn hon yn 

wag.  

Mae'r daenlen yn tybio bod y 

cyfraniad pensiwn cyflogwyr yn 

ganran sefydlog o dâl crynswth 

cyflogwyr. Os nad dyna'r achos 

mae'n rhaid i chi gyfrifo'r 

cyfraniad pensiwn cyflogwyr ar 

wahân. Os ydych yn ansicr, 

siaradwch â'r sawl sy'n rheoli eich 

cyflogres.  

http://www.hmrc.gov.uk/rates/nic
http://www.hmrc.gov.uk/rates/nic


 

 


